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Customer Service

We support you...

By phone/Fax in the USA.

Customer service is available from 9:30 AM to 6:00 PM USA Eastern Time, Monday through
Friday at +1 (216) 241-7225. We’re often here at times outside of these, as well – please feel
free to try at any time!  Fax: +1 (216) 241-4103.

By phone/Fax in Europe.

Service is available from Telos Europe in Germany at +49 81 61 42 467.

Fax: +49 81 61 42 402.

By E-Mail.

The address is: support@telos-systems.com.

Via World Wide Web.

The Telos Web site has a variety of information which may be useful for product selection.
The URL is: http://www.telos-systems.com.

Feedback
We welcome feedback on any aspect of the Assistant Producer 2.0 or this manual. In the past,
many good ideas from users have made their way into software revisions or new products.
Please contact us with your comments.

Telos Systems
2101 Superior Avenue

Cleveland, OH 44114
USA

+1 (216) 241-7225
Fax: +1 (216) 241-4103

Telos Europe
Johannisstra ße 6

85354 Freising
Germany

+49 81 61 42 467
Fax: +49 81 61 42 402
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TWOx12, Zephyr, ZephyrExpress, and System 2101 are trademarks of TLS
Corporation. All other trademarks are property of their respective holders.

Copyright
Copyright © 2000 by TLS Corporation. Published by Telos Systems, who reserves
the right to make improvements or changes in the products described in this manual,
which may affect the product specifications, or to revise the manual, without notice.
All rights reserved.

Notice
All versions, claims of compatibility, trademarks, etc., of hardware and software
products not made by Telos mentioned in this manual or accompanying material are
informational only. Telos Systems makes no endorsement of any particular product
for any purpose, nor claims any responsibility for operation or accuracy.

Warranty
This product is covered by a one year limited warranty, the full text of which is
included in the Appendix of this manual.

Service
You must contact Telos before returning any equipment for factory service. Telos
Systems will issue a Return Authorization number which must be written on the
exterior of your shipping container. Please do not return cables or accessories
unless specifically requested by Telos technical support. Be sure to adequately insure
your shipment for its replacement value. Packages without proper authorization may
be refused. US customers please contact Telos technical support at +1 (216)-241-
7225. All other customers should contact your local representative to make
arrangements for service.
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1 INTRODUCTION- What is Assistant Producer 2.0?

Welcome to Telos Systems’ Assistant Producer 2.0 Talk Show Management
Software.

Congratulations on choosing Assistant Producer 2.0, which completes Telos
Systems’ advanced third generation digital multi-line talk show systems by
addressing the need for Windows-based client/server call screener software.  This
system enables producers to provide talent with information on each caller, send
instant messages, and control the status of multiple telephone lines.

Assistant Producer 2.0 integrates easily with your Telos phone systems and allows
for maximum control and flexibility through a user-friendly Windows environment,
even from remote locations.

Your new Assistant Producer 2.0:

 Supports Windows 95, 98, NT or higher.

 Serves as either a talent or producer workstation via a PC.

 Features line selection and control over the network by keyboard and mouse.

 Contains distinctive Status Symbol ™ line indicators (icons) matching those
used on Telos’ Desktop Director™ for ease of use.

 Helps manage your show by providing line timers and the show scheduler.

 Houses a flexible database, which allows the saving of your show statistics.

 Writes database records using Microsoft Access database protocols for easy
manipulation of database information, and to convert to other formats to use
with your favorite database applications.

Contained in this manual is information on how to install and use Assistant Producer
2.0.  The flexibility of this system is great, so we encourage you to “play with” the
system, and configure it thoroughly before putting it on the air.
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2 SYSTEM INTEGRATION

The Assistant Producer 2.0 Windows based talk show software works in conjunction with
Telos 3rd generation phone systems utilizing the Desktop Director™ integrated
telephone/control surface, such as the TWOx12 and System 2101. Assistant Producer 2.0
adds additional flexibility and power to these phone systems by providing the ability to
manage talk shows in the Windows environment.

w
IMPORTANT TIP!

Assistant Producer 2.0 works only with Telos 3rd generation systems such as
the TWOx12 and System 2101. If you have an older Telos phone system using
a 1A2 interface, Direct Interface module, or One-x-Six you should use
Assistant Producer 1.17 instead. This is included on the CD-ROM along with
Assistant Producer 2.0.

Assistant Producer 2.0 communicates with the “embedded server” built into the Telos
Interface such the TWOx12 or System 2101 over any Ethernet based network using the
TCP/IP protocol. This means that Assistant Producer 2.0 will function over any LAN,
WAN, or other TCP/IP based computer network. Assistant Producer 2.0 can even be used
from remote locations via the Internet if your corporate LAN has Internet access.

Assistant Producer 2.0 can be configured to either control/monitor a specific Desktop
Director™ or the system as a whole (“No Director” mode).

Assistant Producer 2.0’s “No Director” mode does exactly what the name implies. It can be
used to control/monitor activity of the Telos phone system without being directly
associated with any specific Desktop Director. This is useful for remotely
managing/monitoring the overall flow of a talk show instead of just the activity on one
Desktop Director™.

Assistant Producer 2.0 is designed to operate in one of two modes on any given computer
at a given time:  “Talent” (on air control mode) and “Producer” (screener mode).  These
two modes provide the user with features designed specifically for the intended use.

Assistant Producer 2.0 uses easy to understand Status Symbols™ (icons) to indicate status
information about each line.  These icons are identical to those used on the Telos Desktop
Director™ so there is no confusion. There is only one simple easy-to-recognize set of icons
for the whole phone system.

Assistant Producer 2.0 provides 4 general fields for entering/displaying Caller information
so the Talent can easily see vital information on his/her caller’s (name, location/address,
comments, and phone number).  Assistant Producer 2.0 can also be easily configured to
automatically log the call information to a user selectable database.

To help manage your talk show Assistant Producer 2.0 has an easy to use “Show
Scheduler”. The “Show Scheduler” can be programmed to give you warning/notification
for commercials, breaks, new topics, etc.
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Instant messages can be sent through the easy to use “chat” style message box. Just type
your message and press the enter key and all running copies of Assistant Producer 2.0 will
receive the message. This provides show personnel a method to effectively communicate
while on air.

Typical System Scenario:

STUDIO……………………… : ……… SCREENER LOCATION

As indicated above, typically the screener and talent will each have a Desktop Director™ and a
computer running Assistant Producer 2.0. Each copy of Assistant Producer 2.0 will usually be

“logged into” a particular Desktop Director™, allowing control of that Director via the software. This
“logical connection” between the Desktop Director™ and the copy of Assistant Producer 2.0 below

it is not indicated on this diagram.

Assistant Producer 2.0 provides you with an easy to use Windows based environment to
manage your talk shows.  It gives you great flexibility by being able to manage show from
just about anywhere a TCP/IP connection can be found.

System Requirements

PC Requirements:

CPU: Pentium Class processor (Minimum) – Pentium 166MHz or greater (recommended)

OS: Windows 95, 98, NT 3.51 or higher.

Drives: CD-ROM required for installation; 20 MB minimum disk space required (additional
space required for caller logging, if used)

Memory: 16 MB (Minimum) – 32MB or greater (recommended)

Video Card: SVGA card capable of 16-bit color and 800x600 resolution. 1024x768 resolution
(Recommended)

Misc: Ethernet Card; 10 Base-T (recommended)

TWOx12

Producer
(Screener)
Desktop
Director

Talent
Desktop
Director

Copy of
Assistant

Producer 2.0
(Talent  Mode)

Copy of
Assistant

Producer 2.0
(Producer

mode)Network Hub
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LAN Requirements:

Network: Any Ethernet based network capable of using the TCP/IP protocol; TWOx12
accommodates Ethernet 10 Base-T, other types of networks would require protocol
converters.

Supported Protocols: TCP/IP

Telephone System Requirements:

Telephone Interface:

Telos TWOx12 version 1.0 or later.

Telos System 2101 (check with customer support for version information)

*NOTE:  If control of the TWOx12 from a remote (off-site) location is desired the LAN must have
Internet access.



TELOS ASSISTANT PRODUCER 2.0 USER’S MANUAL

SYSTEM INTEGATION

CHAPTER 2 6

This page intentionally left blank



3 Software Installation

The installation of Assistant Producer 2.0 is simple and straightforward.  First close all other
applications that are running on your computer.  Then put the Assistant Producer 2.0
Installation CD into your CD-ROM drive, run the Setup.exe file and follow the on screen
instructions.

Running Assistant Producer 2.0 for the first time

After the installation process is complete you now have to configure Assistant Producer 2.0.

1. Start Assistant Producer 2.0 (from the programs menu) and you will see the
following screen:

This is the default Assistant Producer 2.0 screen. Since you are not yet “logged on” to a server
(Telos phone system such as the TWOx12 or 2101) the top of the window is blank, except for

“Assistant Producer 2.0”.

2. The next thing you need to do is specify a Telos TWOx12 (Server) for Assistant
Producer 2.0 to connect to. This is accomplished by going to the “Connection” menu
and selecting the “Server Properties” option. The following screen will then appear:
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3. In the IP Address field you will need to enter the IP address of the Server (Telos
phone system such as theTWOx12 or 2101) that you want to connect to. For
example:  XXX.YY.ZZ.AAA . This is the IP address entered in the Telos phone
system.

The Socket field all ready contains the default socket number for the Telos TWOx12.  By
no means should the socket number be changed unless instructed otherwise.

h
HOT TIPS!

• If you have never set up a network before we have provided some helpful
suggestions in Appendices 2 & 3.

• If you have not yet entered an IP address in your Telos phone system
please refer to the manual that came with that equipment.

• If you are on a managed network, request an IP address to enter into the
Telos phone system from your System Administrator.

4. After filling in the appropriate data click OK and you will be connected to the Server.

Note that you will be able to determine if the connection was successful. Near the bottom
right hand corner of the “Message Window,” on the main Assistant Producer 2.0 screen,
you will see what looks like two little computers connected by a cable.  This icon is for
indicating the connection status of Assistant Producer 2.0.  When the “screens” on the
computers are blue Assistant Producer 2.0 is not connected to a server.  When the
“screens” are green AP is connected to a server.

Disconnected from server.     Connected to server.

5. After the connection is established, you will have to configure how Assistant
Producer 2.0 will act and what it will control.  You first need to choose what
Desktop Director™ you are going to control.  Go to the “Configuration” -> “Desktop
Director” menu, where you will find a list of all the currently available Desktop
Directors to control.   You will notice that the last choice in the list will be “No
Director”.  The “No Director” option allows you to be connected to the TWOx12 but
not have control of any particular Desktop Director™.  Make your selection by
clicking on the desired choice.
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h
HOT TIP!

If you do not know what the name or number of the Desktop Director you want to
control, it can be found in the upper left hand corner of its display (i.e. “DD1”).

6. The next option you will need to set is mode, also under the Configuration menu.
Under the mode menu there are two choices “Producer” and “Talent”.  These choices
are only relevant when Assistant Producer 2.0 is running in the “No Director” mode.
If you have chosen to control a specific Director as described above you will not be
able to make a selection here, because Assistant Producer 2.0 automatically mimics
the mode of the Desktop Director™ you are controlling.

w
IMPORTANT TIPS!

Desktop Director Selection

1. Each Desktop Director™ in the system has an ID number (or
name). If Desktop Directors are removed from, or added to, the
system this number might change. The current number for a
given Director is always displayed near the top left of the
Director screen.

2. Each Desktop Director™ can be in one of two modes: Talent
mode allows control of the system’s hybrids and allows caller to
be put on-air.

3. Producer mode turns the Desktop Director into a deluxe call
screener telephone.

h
HOT TIP!

The mode cannot be changed not be changed from Assistant Producer 2.0
when controlling a Desktop Director™.  You must go to the Desktop Director
itself and change its’ mode. Assistant Producer 2.0 will then automatically
change to this mode also.  Please refer to the telephone system documentation
for help on changing modes.

7. The final option you will see in the “Configuration” menu is “Studio”. Since the
Telos 2x12 is only capable of running one studio this option is only applicable if you
are using the Telos System 2101. Please consult the System 2101 manual for
information on setting up and managing
studio groups.

8. After you have configured Assistant
Producer 2.0 you should save the current
configuration by exiting Assistant Producer
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2.0 by choosing “Yes” when prompted to save the current settings. We suggest you
do this now as your settings will need to be re-entered if the program is shut in some
irregular fashion. The next time Assistant Producer 2.0  is started it will now
automatically connect to server and load the saved configuration.

h
HOT TIP!

If more than one copy of Assistant Producer 2.0 is being run on one Computer,
only a single set of configuration settings will be saved. This will be the
configuration of the last copy of Assistant Producer 2.0 to be shut down.



4 Using Assistant Producer 2.0

The first step to using Assistant Producer 2.0 is to learn what the different Status Symbol™
icons mean. You will find a detailed explanation of these icons in Appendix 1 and in the
documentation for your Telos telephone interface. Please take some time to familiarize
yourself with the Status Symbols to help eliminate any confusion.

h
HOT TIP!
We suggest that you familiarize yourself with your system’s normal Desktop
Director™ operation prior to using Assistant Producer 2.0. See your TWOx12 or
System 2101 manual for detailed information specifically for Talent and Producer
modes.

Like the Desktop Director™ Assistant Producer 2.0 has two basic modes, “Producer” and
“Talent”.  The screen will look similar between the two modes, but the functionality differs.
So please read over this section carefully so you understand the operation of Assistant
Producer 2.0 in each of the two modes.

The main difference between Producer and Talent mode is the functionality of the group of
buttons on the right side of the screen.  Other than this group of buttons, Assistant Producer
2.0 functions the same in both Producer and Talent modes.

4.1 Producer Mode (screener mode)

Producer mode is used primarily by the call screening staff.  It has all the usual caller data
entry features (Name, Location, Comments, etc.).  In addition, the call screener can modify
the “Next” cue;  the screener can designate any caller in the “screened hold” cue as being
“Next”.  However,  Producer mode does not give you control of the TWOx12’s hybrids,
therefore it is not possible to place callers on the air in this mode.
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w
IMPORTANT!

When Assistant Producer 2.0 is not attached to a Desktop Director (i.e. when in
No Director Mode) “Producer” mode does not have full functionality.  The line,
next, hold, drop, and screened hold buttons are not functional. That it is because
these buttons are for use by the screener, to control who they are talking to on
their Desktop Director™.

 The message window, caller data fields, record, busy all, delay dump, and dial
pad buttons are fully functional in No Director mode.

Buttons in Producer Mode

 Next Button

In Producer mode the next button will pick up the line that has been ringing in the longest.  If
there are not any ringing lines the next button will pick up the line that has been on hold the
longest.

 Hold Button

In Producer mode the hold button will put the active line (caller on handset or speakerphone)
on hold.

A
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Assistant Producer 2.0 in Producer mode. Producer mode looks the same, but operation of the buttons (described

in the text) is different in the two modes. Note that the top of the window identifies the Studio, Desktop Director

(Console) and mode at a glance. Our example shows a studio configuration of only 4 lines, however larger systems

are supported.
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 Drop Button

In Producer mode the Drop button will drop any active lines.  Lines that are locked, on hold,
screened hold or on air will not be dropped.

 Screened Hold Button

In Producer mode the screened hold button places the active call on screened hold. Screened
hold is the “next cue” which is accessed by the talent when s/he presses the next button when
in Talent mode.

Line Buttons – Left Bank

In Producer mode the functionality of the left bank of line buttons depends on the current
state of that line. If the line is in the “on hook” (idle) state when the line button is pushed, the
line will either be put on speakerphone or the handset (whichever one the Desktop Director
AP is controlling is set for).  If the button is then pushed again the line will be put into the
“locked” state.  To unlock the line, push the line button again.   If the line is in the “hold”
state pressing the line button will then take the line off hold.  If the line is in the “screened
hold” state pressing the line button will pick the line up.  If the line is in the “ringing” state
pressing the line button will “answer” that line.

Line Buttons – Right Bank

In Producer mode the right and left bank of line buttons have two different functions.  The
right bank of line buttons can be used to put the corresponding call on screened hold.  The
right bank of line buttons can also be use to reorder the “ready cue” (screened hold) if there is
more that one line on screened hold.  When a line is in the “screened hold” state and the right
line button is pressed. that line will designate as next (first in the cue).  The rest of the cue
will be in the regular order (longest to shortest amount of time on hold).

? CURIOSITY NOTE!

The following buttons work identically in both Talent and Producer modes!

 Record Button

The “Record” button acts the same as the “Record” button on the Desktop Director.  This
button is generally used in conjunction with an external recorder.  It allows you to
automatically capture caller audio, while stopping when no caller is present.  Pressing this
button once places the system in “ready” status.  For more information on this function, or
setup of this button, please refer to the Telos Telephone Interface documentation.



TELOS ASSISTANT PRODUCER 2.0 USER’S MANUAL

USING ASSISTANT PRODUCER 2.0

CHAPTER 4 14

 Busy All Button

The “busy all” button will clear all lines when pressed. With the only exceptions being lines
in the locked state, lines on hold, and lines pre-designated not to be part of the busy-all-group
(such as direct dial-in lines like the studio hotline). Unlocked lines on-air, lines on hold, and
lines on screened hold will be dropped. Those lines will then be blocked from accepting any
calls (in most cases the caller will get a busy signal, but this will not always be true
depending on your configuration) and the “Busy All” icon will be displayed.

Pressing the “busy all” button again will clear the lines and allow incoming calls (in some
configurations callers attempting to call while you are in the Busy All state will hear ringing.
In that case the system will answer and drop those callers when you cancel busy all mode).
For more information on the function of “Busy All” please refer to the Desktop Director
documentation.

 Delay Dump Button

The “Delay Dump” button functions the same as the “Delay Dump” button on the Desktop
Director. It is typically used to control a piece of equipment external to the TWOx12 such as
the “delay dump” on an obscenity delay unit.  For more information on the “Delay Dump”
button please refer to the TWOx12 and Desktop Director documentation.

 Dial Button

The “Dial Button” allows you to make a call from AP.  To use the dial feature you first need
to select a line (put it on the speakerphone, handset, or a hybrid) and then press the “Dial”
button.  The following screen will then be displayed.

The number you wish to dial can either be entered by using the provided keypad or by typing
the number into the Phone Number field.  The digits are dialed as they are either typed or
pressed on the keypad.  Since this is the case, this works just like a regular phone, if you
make a mistake dialing the number, you must hang the line up, pick it back up and then retry.   

The last 10 numbers that you have dialed are available by using the drop down feature of the
Phone Number field.  To redial a number select the number out of the drop down box by
clicking on it (the number should appear in the number field.  Then press the Redial button.
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If the Redial button is pressed with out first selecting a number from the drop down box the
number that was lasted dialed will be dialed.

4.2 Talent mode (on-air control mode)

The “Talent” mode can be thought of as an enhanced, PC based, Telos Desktop Director™
with caller information displayed next to each line.  This mode is used primarily by the on-air
Talent since it provides direct control of the TWOx12’s two built in hybrids.

It is important to understand that the left row of line buttons double as hybrid control mode
(Caller 1 hybrid) and studio telephone mode (handset or speakerphone). If the speakerphone
is active (LED lit next to the speakerphone button) or the handset is off-hook the left line
buttons will route calls to the phone rather than hybrid 1 (Caller 1 hybrid). More on this

below.  Next Button

In Talent mode the next button picks up the next call in the ready (screened hold) cue.  If
there are no calls on screened hold pressing the next button will pick up the call that has been
on hold the longest.  If there are no calls on hold pressing the next button will pick up the line
that has been ringing the longest.

 Left Hold Button

In Talent mode the left hold button puts any calls active on the left (Caller 1) hybrid or the
handset/speakerphone on hold.

 Right Hold Button

In Talent mode the left hold button puts any calls active on the right (Caller 2) hybrid on
hold.

Assistant Producer 2.0 in Talent mode. Note that the top of the window identifies the Studio, Desktop Director

(Console) and mode at a glance. Our example shows a studio configuration of only 4 lines, however larger systems

are supported.
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 Left Drop Button

In Talent mode the left drop buttons drops any lines on the left (caller 1) hybrid or the
handset/speakerphone that are not in one of the following states: locked, hold, or screened
hold.

 Right Drop Button

In Talent mode the right drop button drops any lines on the right (caller 2) hybrid that are not
in one of the following states: locked, hold, or screened hold.

Line Buttons – Left Bank

In Talent mode the way the left bank line buttons function depend on the state of the line.
When line is in the “on-hook” state there are few factors that regulate how the line button
works.  These factors come directly from the Desktop Director™ operates.  If the Director is
set to speakerphone mode then a left line button press will put the call on the speakerphone.
If the Director’s handset is picked up a left line button press will put the call on the handset.
If the Desktop Director is not set to speakerphone and the handset is on-hook, then a line
button press will put the line on the left (Caller 1) hybrid.

If a line is in the “speakerphone” or “handset” pressing a left line button will put the call on
the left (Caller 1) hybrid.   Pressing the button again will lock the line on this hybrid.  As
usual, the line is unlocked by pressing that line button again.

If the line is in the “hold” state a pressing a left line button will take the call off of hold.  If
the line is “on-hook” a pressing a left line button press will pick the line up.  If the line is in
the “right hybrid” state a line button press will transfer the line to the “left hybrid”.

Line Buttons – Right Bank

In Talent mode the way the right bank line buttons function depend on the state of the line.
When line is in the “on-hook” state a right line button press will put the line on the right
(Caller 2) hybrid.

If the line is in the “speakerphone” or “handset” state a right line button press will put the line
on the right (Caller 2) hybrid.   Pressing this line button again will lock the call on this
hybrid. The line is unlocked by pressing that line button again.

If the line is on hold pressing the right line button will take the line off of hold and put it on
hybrid 2 (Caller 2 hybrid).  If the line is on-hook pressing the right line button will put the
call on hybrid 2 (Caller 2 hybrid).  If the line is on the hybrid 1 (Caller one hybrid, left
hybrid) pressing the right line button will move the caller to hybrid 2 (Caller 2 hybrid).
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? CURIOSITY NOTE!

The following buttons work identically in both Talent and Producer modes!

 Record Button

The “Record” button acts the same as the “Record” button on the Desktop Director.  This
button is generally used in conjunction with an external recorder.  It allows you to
automatically capture caller audio, while stopping when no caller is present.  Pressing this
button once places the system in “ready” status.  For more information on this function or
setup of this button please refer to the Telos Telephone Interface documentation.

 Busy All Button

The “busy all” button will clear all lines when pressed. With the only exceptions being lines
in the locked state, lines on hold, and lines pre-designated not to be part of the busy-all-group
(such as direct dial-in lines like the studio hotline). Unlocked lines on-air, lines on hold, and
lines on screened hold will be dropped. Those lines will then be blocked from accepting any
calls (in most cases the caller will get a busy signal, but this will not always be true
depending on your configuration) and the “Busy All” icon will be displayed.

Pressing the “busy all” button again will clear the lines and allow incoming calls (in some
configurations callers attempting to call while you are in the Busy All state will hear ringing.
In that case the system will answer and drop those callers when you cancel busy all mode).
For more information on the function of “Busy All” please refer to the Desktop Director
documentation.

 Delay Dump Button

The “Delay Dump” button functions the same as the “Delay Dump” button on the Desktop
Director. It is typically used to control a piece of equipment external to the TWOx12 such as
the “dump” on an obscenity delay unit.  For more information on the “Delay Dump” button
please refer to the TWOx12 and Desktop Director documentation.

 Dial Button

The “Dial Button” allows you to make a call from AP.  To use the dial feature you first need
to select a line (put it on the speakerphone, handset, or a hybrid) and then press the “Dial”
button.  The following screen will then be displayed.
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The number you wish to dial can either be entered by using the provided keypad or by typing
the number into the Phone Number field.  The digits are dialed as they are either typed or
pressed on the keypad.  Since this is the case, this works just like a regular phone, if you
make a mistake dialing the number, you must hang the line up, pick it back up and then retry.   

The last 10 numbers that you have dialed are available by using the drop down feature of the
Phone Number field.  To redial a number select the number out of the drop down box by
clicking on it (the number should appear in the number field.  Then press the Redial button.
If the Redial button is pressed with out first selecting a number from the drop down box the
number that was lasted dialed will be dialed.

4.3 Features common to Producer & Talent Modes

Keyboard Short cuts – “Hot” Keys

FUNCTION KEY
Drop left <Ctrl> + d
Hold <Ctrl> + h
Drop right <Ctrl> + Shift  + d
Hold 2 <Ctrl> + Shift + h
Left Line buttons Function Key

(Ex: F1 for line 1, F5 for line 5, etc.)
Right Line buttons Shift + Function Key
Next Button <Ctrl> + n
Screened Hold Button <Ctrl> + s
Record Button <Ctrl> + r
Busy All <Ctrl> + b
Delay Dump <Ctrl> + p
Dial <Ctrl> + l
Caller Data Fields <Ctrl> + f

(Takes you to first field)
Navigate Data Fields <Ctrl> + arrow keys
Screen Size Toggle <Ctrl> + t
Debug Window <Ctrl> + Alt + Shift + D
Message Window <Ctrl> + m
User Name Field <Ctrl> + u
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Caller Data Entry

To enter caller data, just click on a field and enter the data.  As much text as needed can be
entered into the comment field.  You will not be able to see the all of this text until you put
the mouse pointer over the comment field.  The comment field will then become a drop down
a box displaying all the text. You can move up and down using the scroll bar on the right side
of this box.

The Message Box

The message box, at the bottom of the screen, provides users with a method of instantly
communicating effectively. The messaging functionality of AP is a “Chat style” design for
ease of use. To send a message, simply click on the Message Window and type your message.
When finished typing hit the <enter> key to send the message.  As messages are sent and
received they will scroll automatically scroll up the message box.  Use the scrollbar located
on the right side of the message box to scroll up and down through the messages.

User Name

Just above the top right hand corner of the actual message box there is a textbox to enter a
user name.  By default this name will say “UserName”.  To change the name double-click on
the text and you can then edit the name.  The name in this box is attached to any messages
that are sent through the “Message Box”.  Your name will then appear next to your message
so that the receiver can easily see whom the message is from.  If you choose “Yes” when
exiting Assistant Producer 2.0 to save the settings, the name will be saved.  Next time you
start Assistant Producer 2.0 the name will then already be there.  This allows the on-air staff
to easily recognize who is typing what during a show, eliminating any confusion.
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5 Advanced Features

5.1 The Show Scheduler

The “Show Scheduler” provides you with an easy, straightforward method of managing your
talk show.It can be programmed to give you warning/notification for commercials, breaks,
new topics, etc.  A specific schedule can be made using hours, minutes, and seconds.

 Substituting “xx” for the hour (such as “xx:20:00”) will cause the clock to “loop” the events
on the schedule every hour.  This is extremely useful when your show(s) are stretched out
over the day, but breaks and events always happen the same time past the hour.  For example
if your breaks occur every 10 minutes enter them as xx:10:00, xx:20, xx:30, etc.

Creating a Schedule

To create a “Show Schedule” go to the “Option -> Show Scheduler” menu and choice the
“View Show Scheduler” option.

An empty Show Schedule form will then appear.

You must now either create a new Schedule File or open an existing one.  To create a new
Schedule File:

• Select “New” from the File menu and
then enter a name for the file.

• To open an existing Schedule File select
“Open” from the File menu and choose
the file you wish to open.

• To start creating the new Schedule first
enter the time the show starts in the
“Show Start Time” Field and the time
the show is over in the “Show Stop
Time” field. The times must be entered
using a 24 hour format (i.e. midnight =
0:00 while noon = 12:00)  Then go down
the list and fill in the “End Time” field
with the event end time and the “Event”
field with an event description. Note:
The “Start Time” field of the next event
is automatically filled in for you.
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Sample schedule:

To enable a show schedule select Show Scheduler from the option menu and then click on
enable show scheduler.

When the Show Schedule is enabled you will see the event information with the clock in the
bottom left hand corner of the screen.  Inside the “dots” of the clock you will see two times.
The top time is the remaining “countdown time” to the next event (hours: minutes: seconds).
The bottom time is the actual system time.  Below the clock you will see
the description of the next event.  For example in the picture below there
is 1 minute and 8 seconds left before the start of the program and the
system time is 5:58:52 PM.

When there is less than one minute left before the next event is to occur
the dots on the clock turn yellow.  When there is less than 30 seconds
left before the next event is to occur the dots on the clock turn red.



TELOS ASSISTANT PRODUCER 2.0 USER’S MANUAL

WARRANTY

CHAPTER 6 23

5.2 The Calls Database

To help you keep records of your talk show Assistant Producer 2.0 has a built “Caller
Logging” feature.  The Calls Database works as follows:

1. Your phone screener enters information on each caller used on air.

2. The information is displayed on the appropriate phone line for the Talent to use during
the show.

3. When each call is terminated (and their data clears from the display), the information for
that caller is logged automatically to the database.  In addition to the information entered by
your phone screener, Assistant Producer will include:

 The date the call was received.

 The time the call was received.

 The amount of time the caller was on hold.

 The total elapsed time the caller was on your phone system.

4. If your screener does not enter anything for a caller, the name field will contain
“Unscreened caller”.

For ease of use and flexibility the database is stored in Microsoft Access compatible format.
This allows you easily sort and edit the database easily using Microsoft Access.   Microsoft
Access will also allow you to convert the database to any other formats you wish to use.  Any
Microsoft Office product should allow you to view the database.

To use the “Caller Logging” feature you must first create a database. To do so:

Go to “Options”->”Caller Data Logging” menu and select the “View Caller Log”.

The following screen will then appear.
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To create the new database select the “New” option from the “File” menu.  Select the path
and filename for the database.  Select the “Open button” and your Database file will be
created.

If you have already created a database using Assistant Producer 2.0 you can open it by
selecting the “Open” option in the “File” menu.  This allows you to switch database for
different shows.  So if you run three different talk shows through out the day you can create
three different databases and just switch to the appropriate one.

To enable “Caller Logging” select the “Enable Logging” option from the “Options”->”Caller
Data Logging” menu.  Now every time a caller is dropped all their pertinent information will
be stored in the database.

5.3 Labeling Line Names

Assistant Producer 2.0 allows you to choose whether line names or line numbers are
displayed on the Left column of Line Buttons. The default mode is to display line numbers.
Before Assistant Producer 2.0 can display line names you must first enter names or labels for
each line.  To enter line names:

Select the “Edit Line Names” option from the “Options”->”Line Labeling” menu.  A “Line
Name Configuration” screen will then appear.
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Enter line names for the appropriate lines.  If the field for a line is left blank, the “Line
Button” will be blank also.  Once you are done entering line names hit OK.

To switch between line names and line numbers select the desired option from the “Options”-
>”Line Labeling” menu.

Note that when line names are chosen the “Right Line Buttons” still displays the line
numbers.   This allows you to see what the actual physical line number is at a quick glance.

5.4 Screen Resizing

Assistant Producer 2.0 gives you two options for viewing the screen.  You can either view it
in the normal default size or switch to full screen mode.  To toggle between the two sizes you
can either pressing the “Control” and “t” keys simultaneously or select the “Toggle Screen
Size” option from the “Options” menu.

*Note:  Assistant Producer 2.0 only supports “full screen” mode when your desktop
resolution is set to 800x600 or 1024x768.
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6 Warranty

TELOS ASSISTANT PRODUCER 2.0 LIMITED WARRANTY

This Warranty covers “the Products,” which are defined as the various audio equipment,
parts, software and accessories manufactured, sold and/or distributed by TLS Corp.,d/b/a
Telos Systems (hereinafter “Telos Systems”).

With the exception of software-only items, the Products are warranted to be free from defects
in material and workmanship for a period of one year from the date of receipt by the end-
user. Software-only items are warranted to be free from defects in material and workmanship
for a period of 90 days from the date of receipt by the end-user.

This warranty is void if the Product is subject to Acts of God, including (without limitation)
lightning; improper installation or misuse, including (without limitation) the failure to use
telephone and power line surge protection devices; accident; neglect or damage.

EXCEPT FOR THE ABOVE-STATED WARRANTY, TELOS SYSTEMS MAKES NO
WARRANTIES, EXPRESS OR IMPLIED (INCLUDING IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE).

In no event will Telos Systems, its employees, agents or authorized dealers be liable for
incidental or consequential damages, or for loss, damage, or expense directly or indirectly
arising from the use of any Product or the inability to use any Product either separately or in
combination with other equipment or materials, or from any other cause.

In order to invoke this Warranty, notice of a warranty claim must be received by Telos
Systems within the above-stated warranty period and warranty coverage must be authorized
by Telos Systems. If Telos Systems authorizes the performance of warranty service, the
defective Product must be delivered, shipping prepaid, to: Telos Systems, 2101 Superior
Avenue, Cleveland, Ohio 44114.

Telos Systems at its option will either repair or replace the Product and such action shall be
the full extent of Telos Systems’ obligation under this Warranty.  After the Product is
repaired or replaced, Telos Systems will return it to the party that sent the Product and Telos
Systems will pay for the cost of shipping.

Telos Systems’ authorized dealers are not authorized to assume for Telos Systems any
additional obligations or liabilities in connection with the dealers’ sale of the Products.

Telos products are to be used with registered protective interface devices that satisfy
regulatory requirements in their country of use.
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7 Appendices

7.1 Appendix 1 – Assistant Producer Line State Status Symbol™ Icons

Line is on-hook and Available (idle):

Line is in use Elsewhere:

The Line is Ringing:

Call is on Hold:

Call is On Air – Left Hybrid:

Call in On Air –Right Hybrid:
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Call is Locked - Left Hybrid:

Call is Locked – Right Hybrid:

Call is on hold and has been screened (Screened –Hold):

Call is hold, has been screened, and is Next (Ready-Next):

Line is busied out (Busy All):

Line is on Speakerphone:

Line is on Handset:
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Line is OFF – not operational:
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7.2 Appendix 2 – Are you new to PC Networking?

We at Telos recognize that there are many people like you out there, so we put together
this guide to help you through the installation.

Here’s some helpful instructions for the first time user of a computer network.

You just got Assistant Producer2.0 today, and you have to have it running yesterday.
Only one problem…  You never set up a computer network in your life!  Arrgh!

This section describes how to get your new call screening system up and running
using entirely “off the shelf” parts.

What to do:

• Establish where you want to install the PC’s for Assistant Producer 2.0, and
how you are going to run the network wiring.

• Get the hardware. Before you hop into the truck to run to the computer store,
read this whole section first! To make setting up a network go as smoothly as
possible, we recommend buying an Ethernet network card for each PC, and a
mini Ethernet network hub.  Using 10 Base-T cards & hub will be more than
satisfactory for Assistant Producer 2.0.  10/ 100 Base-T based networks are
easy to set up & maintain when compared to the old “coax cable” based
networks.  You should figure out how much network cable would be needed
to go between each PC, TWOx12, and the network hub.  What kind of cable
to buy? The category 3 type Ethernet cable is just fine for 10 Base-T
networks. When faced with really long cable runs, or facilities with a lot of
RFI, it might be worth the cost to use category 5 cable. If this is to be the
start of a studio computer LAN system, just go with the category 5 cable.
Why?  It won’t be long before you will have to go 100 Base T, and that
requires the use of category 5 cable!

• While you are at the computer store, buy “Networking for dummies” or a
similar introductory text. Not that you are a dummy, but this book will
answer a lot of networking questions that we do not have the space and time
to cover in this manual!
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h
HOT TIPs!

When buying network hardware: Stick to regular brands made by
larger companies such as “Maxtech”, or “Linksys”.  These larger
companies will often sell a complete “network in a box”, which has all
the necessary hardware & instructions to network two (maybe more) PC’s
literally in one box.

Buying no-name brand cards will work just fine, but they sometimes
come with less than clear documentation.   Experienced network
administrators can easily “feel “ their way through the installation of the
cheaper cards.  New people (like you) will find the lack of clear
instructions very frustrating!

After you get the equipment to your facility, you will want to install the hardware,
install the necessary drivers, connect each PC to the Ethernet hub, and see if they can
talk to each other.

Have your Windows disks handy.  You will need them.

You might also need your Windows networking book we told you to buy earlier!  A
good reference book will answer all your network-specific questions!

You can check for proper communication by clicking onto the “Network
Neighborhood” icon on the desktop screen for each PC.  You should see both
computer names displayed in the “Network Neighborhood” dialog box on each PC.
Sometimes it will take a few minutes after the initial boot-up for anything to be
displayed in these windows.  This is normal.

If the following happens:

Your Network Neighborhood window shows a flashlight, and eventually gives you
an icon for “Entire Network”.   You click on the “Entire Network” icon, and you get
an icon for “Workgroup”.

OR

You click on the “Workgroup” icon, and get the “Entire Network” icon…

The computer is not properly set up.  Re-check your network setup.  This is
where the reference book we told you to buy comes in handy. There is probably
just one thing not set up correctly.  Carefully going through your setup
procedures should shed some light here.

If you click on “Network Neighborhood”, and only see the computer you’re working
on displayed, then that computer is talking to the network card (at least), but the
communications is not getting any farther than there.  First check your local
configuration, then re-check the network settings on the other computer  (Maybe it is
not talking).

TCP/IP is the easiest to setup, and the most flexible to use.  This protocol will have to
be installed from your Windows 95/98/NT disks.  After this is done, you can go to
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Chapter 2, and start the installation of Assistant Producer.  For a review of how to use
Assistant Producer on TCP/IP, see “The Complete Guide to TCP/IP”.

Giving your computer an identity on the network

• In order for any network of computers to work, you need to establish an
identity to each computer.  This ID can range from a word, or name, as used
in a Microsoft (Net BEUII) peer to peer network - to a special number, such
as an IP address, which is required for TCP/IP.

• In the Microsoft peer to peer approach, the name of a particular computer can
be anything you want, whether it be something as cold as “Station 3”, or
something with character, such as “Oscar”.  The choice is yours.

• You can also run multiple protocols.  For example, you can run Net BEUII, a
Microsoft peer to peer network protocol, which requires (regular) computer
names, and simultaneously run TCP/IP  over the same network.

In the above situation, your computer will have two identities.  1) The
(word) name used by Microsoft Net BEUII and 2) The IP address
(number) for TCP/IP.

Any program application designed to look for a Microsoft computer (name) identity
(such as Remote Automation Manager) will connect to that PC by first searching for
the name of the required server PC over the network.

Any program application, which requires an IP socket connection (such as TCP/IP
Winsock), will search the network for the IP address of the server PC, and then
establish a connection to the server software.

To assign an ID to your PC on a Microsoft Network, go to the “Network” setup icon
in your Windows 95 “Control Panel”, click on the “Identification” tab, then define a
“computer name”, and define a “workgroup”.

What is a workgroup?  A workgroup can be thought of as an electronic “office”
where multiple computers can be assigned to exist.  By default, Windows assigns a
generic workgroup called “Workgroup” to any unspecified workgroup entries.  (See
your Windows 95 or NT instruction books for more information).
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7.3 Appendix 3 – TCP/IP Setup Guide

h
HOT TIP!

The “PING” Test: Here’s an extremely useful test diagnostic tool: “PING”

If you can ‘ping’ the desired TWOx12 with TCP/IP, Assistant Producer 2.0
will be able to connect.

If you are using TCP/IP, you should perform this test before installing any
of our software.  If you pass this test, you should have no problem using
Assistant Producer or Assistant Producer 2.0.

MAKE SURE YOU HAVE ALREADY SET UP YOUR TCP/IP NETWORK
PROTOCOLS BEFORE PERFORMING THE PING TEST!

A “Ping Test” is accomplished in this way:

• Go to the MS-DOS prompt window, and type “PING <the IP
address of the TWOx12 of interest>”

• Example: “Ping 168.192.0.1”.  Your PC will then “Ping” the
TWOx12 at the far end with 32 bytes of data, and will report the
status of the ping test.

If you get messages such as “request timed out”, or “host unreachable”
then there is an error in your network configuration, and Assistant
producer will not work.

The TCP/IP protocol is fairly easy to set up to allow operation of Assistant Producer
2.0 over your computer LAN, WAN, etc.

Assistant Producer 2.0 strictly uses the TCP/IP protocol.  In order for this to work,
Assistant Producer 2.0 must look for the TWOx12 IP Address.  After finding the
TWOx12, Assistant Producer2.0 will negotiate with the server, and start operating.

First, find out the IP address used for the TWOx12.  Please refer to TWOx12
documentation on help for setting or finding the IP address.

h
HOT TIP!

There is a block of IP addresses ranging from 192.168.0.1 to
192.168.0.255 that are considered to be safe to use for internal network
purposes. They are not assigned to any server on the internet.

Each device on your TCP/IP network will still need a unique IP address,
even if you use numbers from this block.

The PC running Assistant Producer 2.0  must have its TCP/IP protocol configured
properly.
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To do this you must go to your “network settings” in the “control panel” and check to
see if you are using TCP/IP for any of your communications protocols.  You will find
all of your network adapter protocols under the “adapter bindings” headings.

If you are not using TCP/IP as a protocol, add the option now.  If you have to add the
protocol you will need your Windows OS CD ROM or floppy disks.

After you have verified that you are indeed using TCP/IP as a protocol, you must
make sure that the PC has an IP address assigned.  You have two options here, you
can either assign an IP address or use a “Server Assigned IP”.  Check with your
System Administrator for which option to use.

To assign an IP go to the  “Properties” option for the protocol.  Here you can either
choose “Obtain an IP address automatically or “Specify an IP address”.  Please check
with your System Administrator for an IP address to assign if this option is chosen.
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There!  The PC is ready.
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7.4 Appendix 4 – Using Assistant Producer 2.0 in remote (off-site) locations

How it works:

As long as the network (LAN) that you have your TWOx12 connected to has access
to the Internet Assistant Producer 2.0 should be able to connect.

There is no special software to use.  All you need is Windows 95/98/NT, Assistant
Producer 2.0, and an Internet connection.

To connect to a TWOx12 over the Internet you need to do the following:

• Make sure the computer with Assistant Producer 2.0 installed on it is
connected to the Internet

• Next try to “Ping” the TWOx12 to make sure communication can be
established.  If you get a response from the TWOx12 you should be able to
connect to it with no problem.   For example: Go to the MS-DOS prompt and
type “ping <IP address of TWOx12> <enter> ”

 Manual History

0.9 RKT 03/00


	Customer Service
	Table of Contents
	INTRODUCTION- What is Assistant Producer 2.0?
	Welcome to Telos Systems’ Assistant Producer 2.0 Talk Show Management Software.
	Your new Assistant Producer 2.0:

	SYSTEM INTEGRATION
	Typical System Scenario:
	System Requirements

	Software Installation
	Running Assistant Producer 2.0 for the first time

	Using Assistant Producer 2.0
	Producer Mode (screener mode)
	Buttons in Producer Mode
	Next Button
	Hold Button
	Drop Button
	Screened Hold Button
	Line Buttons – Left Bank
	Line Buttons – Right Bank
	Record Button
	Busy All Button
	Delay Dump Button
	Dial Button


	Talent mode (on-air control mode)
	Left Hold Button
	Right Hold Button
	Left Drop Button
	Right Drop Button
	Line Buttons – Left Bank
	Line Buttons – Right Bank
	Record Button
	Busy All Button
	Delay Dump Button
	Dial Button

	Features common to Producer & Talent Modes
	Keyboard Short cuts – “Hot” Keys
	Caller Data Entry
	The Message Box
	User Name


	Advanced Features
	The Show Scheduler
	Creating a Schedule
	Sample schedule:

	The Calls Database
	Labeling Line Names
	Screen Resizing

	Warranty
	Appendices
	Appendix 1 – Assistant Producer Line State Status Symbol™ Icons
	Appendix 2 – Are you new to PC Networking?
	What to do:
	If the following happens:
	Giving your computer an identity on the network

	Appendix 3 – TCP/IP Setup Guide
	Appendix 4 – Using Assistant Producer 2.0 in remote (off-site) locations


